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Email Encryption Instructions

IMPORTANT
*** Web email does not work when receiving encrypted messages from CDPH***

1) Step one is receiving the email from support@dhs.ca.gov.
Open this email within 4 days of receipt. Check your spam mail if you did not receive this
emall.

‘ =1 Il support@dhs.ca.gov Sis Web Admin Utility Notification [secure]

2) Double click on the file located at the subject line. > message.htlm

From: support@dhs.ca.gov

To: Szalay, Melinda (CDPH-PCFH-GDB)

Ce:

Subject: Sis Web Admin Utility Motification [secure]

—) IMessage | * messagehtml 01 k®)

O
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mailto:support@dhs.ca.gov

Email Encryption Instructions

3) OPEN the attachment. Some worksites will require you to save the attachment. If this is
the case, save the attachment to your desktop and open it from there.

Opening Mail Attachment @

.Q ¥ou should only open attachments from a trustworthy source.

Attachment: message.html from Sis Web Admin Utility
Motification [secure] - Message (HTML)

Would you like to open the file or save it to your computer?

) o

Always ask before opening this type of file

4) Single click on the ONE TIME PASSCODE option located at the bottom of the screen.
Encrypted message

From

support@dhs.ca.gov
To

To view the message, sign in with a Microsoft account, your work or school account, or use a one-time

passcode.

/-3‘\ Sign in

‘ k)’) Use a one-time passcode I
OO0
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Email Encryption Instructions, cont.

5) Leave this Internet browser screen as is and go into your email inbox.

We sent a passcode to melinda.szalay@cdph.ca.gov.

Please check your email, enter the passcode that corresponds with the
reference code, and click continue. The passcode will expire in 15 minutes.

Reference code: 0811

Passcode | |

L] Thisis a private computer. Keep me signed in for 12 hours.

6) Wait for the email from Microsoft Office 365. Open the email and copy the passcode.

‘ | Microsoft Office 365 Message Encryption  Your one-time passcode to view the message

Use the passcode to sign in

85147312 | Copy this passcode

To view your message, type the passcode into the web
page where you requested it. This passcode matches

reference code 0811.

L) '..
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NOTE: This passcode expires 15 minutes after it was /
AN
requested.
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Email Encryption Instructions

7) Once you have copied the PASSCODE, minimize your email screen, this browser screen
should be visible. Paste the PASSCODE into the box, then hit continue.

We sent a passcode to melinda.szalay@cdph.ca.gov.

Please check your emall, enter the passcode that corresponds with the
reference code, and click continue. The passcode will expire in 15 minutes.

Reference code: 0811

‘ Passcode

[] Thisis a private computer. Keep me signed in for 12 hours.

‘ @ Continue



User Name and New Temp password info

8) This screen contains your SIS User Name and temporary password. The User Name
'ts Iczngy lyour first initial and last name. Copy the Temporary Password and click on the
ink below.

Sis Web Admin Utility Notification [secure]
Subject: Sis Web Admin Utility Notification [secure]
Here is your User Name and new temporary password for your Sis Extranet Account.

_ SIS user id is ONLY your first initial and last
Your User name is: dh}ém:\kbmca “= name. Disregard the dhsextra\

Your New Temporary Password is: 8Ck@g%A26q &= Copy the New Temp password

Please click the link below to update your account information and to create your permanent password.
https://ext2.dhcs.ca.gov/WebPassMgr/default.aspx &= Click on this link

If the above link is not clickable then copy and paste it into your web browsers address bar.

Note: Please change your password within fowr (4) days from today's date or
your account may become inactive and your password will need to be reset.

e
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Required Security screen

Gov State of California

DHCS Extranet Password Manager
v1.11.0.0 Log Off

Entry to Password Manager

WARNING This is a State of California computer system thatis for official use by authorized users and is subject to
: e being monitored and/or restricted at any time. Unauthorized or improper use of this system may resultin
HeshthCoreBervices administrative disciplinary action and/or civil and criminal penalties. By continuing to use this system you
indicate your awareness of and consent to these terms and conditions of use.

LOG OFF IMMEDIATELY, if you donot agree tothe conditions stated in this warning.

Please answer the Question below
This is called CAPTCHA and it helps us to protect this site. Thank you for your assistance.

What is the sum of three and seven?

e
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SIS Login screen

-GOV State of California

DHCS Extranet Password Manager
v1.11.0.0 Log Off

DHCS Extranet Login

Forgot Password Forgot User Name  Forgot Securty Question

Login To Manage Your Account

User Name || |&——= Enter your SIS User Name
Password | /== Paste in the Temporary Password
Email | | &= Enter your email

D s —— click
Y
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Security question required

.Gov State of California

DHCS Extranet Password Manager
v1.11.0.0 Log Off

Change Security Question/Answer

Answer Requirements
LAncwer cannot contain aither of theea 2 charactpre:

Answer must contain between 8 and 50 characters

Answer Guidelines

Answers should be treated like passwords

Answers should not be easy to guess

Answers should not be able to be found on the intemet

W;?eu; ﬂ THIS IS REQUIRED IN ORDER TO CONTINUE TO USE THIS SITE

Create a New Security Question / Answer
m . Select a question from the

Question Pleaseselectaqueston Rl drop down

Answer | | &= Answer must be 8 characters

or more.
DEE N — cick |
e
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SIS Change Password screen

-GOV State of California

DHCS Extranet Password Manager
v1.11.0.0 Log Off

Change Password

Password Po “E."V (Passwords must meet the following requirements)

Must Between 8 and 20 characters
Must contain at least:

1 UPPER case letter (A-Z)

1 lower case letter (a-z)

1 digit (0-9)

1 or more of the following $ # @ +_ & =1 %
CANNOT contain any SPACES
CANNOT contain either of these 2 characters = >
CANNOT BE ANY OF YOUR LAST FIVE (5) Passwords

Save OQur
Water E

ITIS REQUIRED TO CHANGE YOUR PASSWORD!

New Password [ceccccees | Follow the password policy
above, then click SUBMIT.

Confirm Password |......... |

s R — e
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Confirmation that password is changed !

-GOV State of California

DHCS Extranet Password Manager
v1.11.0.0 Log Off

Account Management

Change Password

Change Security Question/Answer

Change Email Address

Password Successfully Changed
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SIS PASSWORD CHANGE SUCCESSFUL

9) Successful completion of your SIS password!

10) Open a new Internet Explorer browser session and log into the SIS Portal page

» https://www.cdph.ca.gov/Programs/CFH/DGDS/Pages/sis.aspx

Another path to our portal page is to go to Google and search for SIS CDPH. The first
option is the Screening Information System (SIS) which takes you to our portal page.

11) Save this portal page to your favorites for future access.

Continue

—
e
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https://www.cdph.ca.gov/Programs/CFH/DGDS/Pages/sis.aspx
https://www.cdph.ca.gov/Programs/CFH/DGDS/Pages/sis.aspx

Logging into the SIS Portal Page

12) This is the look of the SIS Portal Page. Locate the Major Links heading and click on

SIS Online Application.

040
California Depar : f -
D A | am looking for lama Programs A-Z Index

PublicHealth o y 9 v

Screening Information System (SI5)

GENETIC DISEASE SCREENING PROGRAM (GDSP)

Screening Information System (SIS)

Note: Before you can obtain access to the Screening Information System (SIS) you must read, sign and fax the Oath Of Confidentiality or NT Oath of

Confidentiality. Contact your program lead to obtain the fax number.
To access the California Codes go to the Official California Legislative Information website.

See the Genetic Disease Screening Program Privacy Policy (PDF).

Major Links

- SIS Online Application |

+ Microsoft Bl Reports
» Update your Personal Information
+ Change your Password

e
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SIS ACCOUNT LOG IN

13) Windows Security box will appear and require the User name. DO NOT type in the
dhsextra\ as part of the user name, then enter the new password.

Windows Security X

The server www.ext.dhs.ca.gov at www.ext.dhs.ca.gov requires a
username and password.

User name |

| Password |

[ Remember my credentials

[ oK H Cancel |

*** Do not check Remember my credentials
****|f you enter incorrect credentials, this box will clear itself and allow for another attempt

14
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SIS Log In (cont.)

14) A standard Warning message will appear, click | Agree.

_GDB-SIS

Warning

This is a State of California computer system that is for official use by
authorized users and is subject to being monitored and/ or restricted at any
time. Unauthorized or improper use of this system may result in
administrative disciplinary action and/or civil and criminal penalties. By
continuing to use this system you indicate your awareness of and consent to
these terms and conditions of use. LOG OFF IMMEDIATELY, if you are not an
authorized user or you do not agree to the conditions stated in this warning.

[ IAgree | | DoNotAgree |
| 4

OO
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SIS compatibility settings; Kaiser users see page 18

» Operating System = Windows version 7 or higher

» Browser = Internet Explorer versions: 9, 10, and 11 . If your facility does have |IE
8 it is possible to force SIS to accept IE8 in the Compatibility View. Open a
browser, go into {TOOLS > Compatibility View Settlngs} Add ca.gov to accepted

websites, then click [Close]. NOIE v 5~ 6][@ consis eorguees
<=
x Esnagt B & : =

Compatibility View Settings

cccccc

» Turn off pop up blockers {TOOLS > Internet Options > Privacy > turn off pop up
blockers}

» Verify the Cookies and Passwords are being deleted in your Browsing History.
Open a browser, go into {TOOLS > Internet Options > General tab> Browsing
History > Delete}, In the Delete Browsing History ensure Cookies and Passwords
have a check in the box next to them, hit Delete. If you have any questions
regarding the compatibility settings on your PC please check with your IT
department. See screen print on following page.
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Deleting Cookies and Passwords

Internet Options

General |Securit',r| Privacyl Contentl Connections | Programs | Advanced|

% =]

Home page

/‘ To create home page tabs, type each address on its own line.

= 1)
i http://www.google.com/ P

l Use current H Use default H Use new tab I

Startup
(") Start with tabs from the last session
(@) Start with home page

Tabs

Change how webpages are displayed in tabs.

Browsing history

Delete temporary files, history, cookies, saved passwords, and
web form information.

Delete browrsing history on exit

l Delete... H Settings I

Appearance

Colors H Languages H Fonts H Accessibility I

l 0K H Cancel I Apply

17

Delete Browsing History

["] Preserve Favorites website data

Keep cookies and temporary Internet files that enable your favorite
websites to retain preferences and display faster.

Temporary Internet files and website files
Copies of webpages, images, and media that are saved for

faster viewing.
Cookies and website data

Files or databases stored on your computer by websites to save
preferences or improve website performance.

[ History
List of websites you have visited.

[ ] pownload History
List of files you have downloaded.

[ "] Form data
Saved information that you have typed into forms.

Passwords

Saved passwords that are automatically filled in when you sign
in to a website you've previously visited.

[] Tracking Protection, ActiveX Filtering and Do Not Track
A list of websites excluded from filtering, data used by Tracking
Protection to detect where sites might automatically be sharing details
about your visit, and exceptions to Do Not Track requests.

About deleting browsing

Delete l [
history

Cancel l

e
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Kaiser users special instructions...

Prior to opening any encrypted message from CDPH, it is necessary to modify your Lotus Notes Preferences.
1) Select the "File" tab, 2) select "Preferences" , look for Basic Notes Client Configuration, 3) Check mark the

"Disable embedded browser for MIME mail“ (see screen shot below). Close this window.

2) Once you log off your current session, this preference change will return to the default settings set by your IT. So
you will need to make this modification each time you open a CDPH encrypted message.

4=

o

-
S’ Preferences

type flter text

Leeounts

I Basic Notes Chent Configuration J

Calendar and To Do

Composite Application Editor

Connections
Contacts

Feeds

Fants and Colors
Horme Portal Sccount
Laeations

Log Settings

[EET

Hotes Ports
Regional Ssttings
Replication and Sync
Search

Spell Check

Toolbar

Web Browser
Widgets

Windoas and Themes

Basic Notes Client Configuration

Startup and shist down

Empty trazh on apphc.ation close
[# rot epnptiad &1 & tmed ntencal]

| bvays sk, z
[¥] ButoSave every |10 =) minutes

Local apphic.ation foldes;
chnobes'udata
#| Check subscriptions
Scan lor unead
|#] Enable scheduled local agents
Drisplay
Defaudt Fonts...
Addihonal ophions
[ v Accept Cookies
¥ Process Pond requests a5 & background task
& Dizable View updates as & background task
v Rt View column sorting
Enabba M5 Difice 97 SendT o ko Holes
Use ‘Web paleite
¥ Show extended acceberators
¥ Enabis MIME save warning
Standard dialog boses
Stinct DrabesTiene Input
Ehowe mvlne MIME images as atlachmenis

|_Disable embedded browses lor MIME mad |
‘wiher bet ng.mgu i unspecified uge the foem's
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Tips

* Never check the box to Remember your
credentials.

 Itis best to change your own password prior
to the 60 day expiration. Go to the SIS portal
page and select Change your Password.

19

Windows Security | 3£

The server sis.ext.dhs.ca.gov at sis.ext.dhs.ca.gov requires a username and
password.

| User name |

| Password |

gRem ember my credentials

[ ok || cancel |

GDSP Screening Information System

Note: Before you can obtain access to the Screening Information System (SIS) you mus
fax the Qath Of Confidentiality or NT Oath of Caonfidentiality Contact your program lead t
number.

To access the California Codes go to the Official California Legislative Information webs

See the Genetic Disease Screening Program Privacy Policy (PDF).

Major Links

5 SIS Online Application

» SIS BO XI Reports

s» Update your Personal Information
3 Change your Password
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